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About this Manual
The manual describes the features of QuickDAQ 2103, how to get started using QuickDAQ 
2013, and how to create a typical application to acquire and analyze data from a data 
acquisition device. 

Note that QuickDAQ 2013 is referred to as QuickDAQ throughout this manual.

Intended Audience

This document is intended for engineers, scientists, technicians, or others responsible for 
acquiring and analyzing measurement data. It is assumed that you are familiar with the 
Windows operating environment, that you are familiar with measurement principles. 

Organization of this Manual

This manual is organized as follows:

• Chapter 1, “Introduction to QuickDAQ,” provides an overview of the features of 
QuickDAQ.

• Chapter 2,  “Quick Start,” describes how to install and start QuickDAQ. 

• Chapter 3, “Understanding the Interface,” describes the basic elements of the user 
interface. 

• Chapter 4,  “Configuring Channels and the Acquisition Settings,” describes how to 
configure the channels and acquisition settings of a supported device using QuickDAQ. 

• Chapter 5, “Configuring the Display,” describes how to configure the settings of the 
Channel Plot and Channel Display windows. 

• Chapter 6, “Example Using QuickDAQ,” provides step-by-step instructions that you can 
follow to create a measurement application. 

• Chapter 7, “Support,” provides technical support information.

An index completes this manual. 
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Conventions Used in this Manual

The following conventions are used in this manual: 

• Notes provide useful information that requires special emphasis, cautions provide 
information to help you avoid losing data or damaging your equipment, and warnings 
provide information to help you avoid catastrophic damage to yourself or your 
equipment.

• Items that you select or type are shown in bold. 

Related Information

This manual is intended to be used with the documentation for your data acquisition device.

Where to Get Help

Should you encounter problems installing or using QuickDAQ, the Data Translation Technical 
Support Department is available to provide technical assistance. Refer to Chapter 7 starting on 
page 121 for information on how to contact the Technical Support Department. 
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Features
QuickDAQ allows you to acquire data, record data to disk, display the results in both a plot 
and a digital display, and read a recorded data file. 

Supported Devices

You can acquire and analyze data from a number of devices using QuickDAQ, including the 
following:

• All DT-Open Layers devices that support A/D streaming

• MEASURpoint instruments

• TEMPpoint instruments

• VOLTpoint instruments

• DT8824 and DT8824-HV instrument modules

• DT8837 instrument modules

Supported Functions

Using QuickDAQ, you can perform the following functions:

• Discover and select your devices.

• Configure all input channel settings for the attached sensors.

• Load/save multiple hardware configurations.

• On each device, acquire data from all channels supported in the input channel list.

• Log acquired data to disk.

• Display acquired data during acquisition in either a digital display using the Channel 
Display window or as a waveform in the Channel Plot window.

• View statistics about the acquired data, including the minimum, maximum, and mean 
values and the standard deviation in the Statistics window.

• Open recorded data in Microsoft Excel® for further analysis.

• You can customize many aspects of the acquisition, display, and recording functions to 
suit your needs, including the acquisition duration, sampling frequency, trigger settings, 
filter type, and temperature units to use.
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Modes of Operation
You can use QuickDAQ in one of two modes:

• Acquisition mode – Use this mode if you want to acquire analog input and/or digital 
input data. This mode requires use of at least one of the supported Data Translation 
devices; refer to page 12 for a list of supported devices.

You can either monitor acquired data without logging it to disk, or record the acquired 
data to disk.

• File reader mode – Use this mode if you want to view a previously recorded data file. 
Note that you cannot acquire new data using the File reader mode.
13
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Resolution Requirements
A minimum vertical screen resolution of 768 is required for proper operation of QuickDAQ.

In addition, it is recommended that you set the default font size to 100%. To do this, select 
Control Panel, Display, and then choose Smaller (100%).
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Installing the Software
A link to the QuickDAQ application is provided on the CD for your device. 

You can also download the latest version of QuickDAQ by going to the Data Translation web 
site.
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Getting Started
To get started with QuickDAQ, follow these steps:

1. Connect a supported device to the network (Ethernet/LXI devices) or to the USB port of 
your computer (for USB devices), and connect your sensors to the device.

2. Start QuickDAQ.
The Device Selection window appears.

Note: If you ran QuickDAQ before and the devices that were used are still present and 
are not acquiring data, the Device Selection window is bypassed. If the devices support 
password protection, you must supply the correct password before the application 
launches. Refer to the user’s manual for your device to determine the default password.

For devices that do not support password protection and that are currently acquiring 
data, a warning dialog box appears notifying you that another application is using the 
device. You cannot continue with QuickDAQ until the device is not acquiring data.

For devices that support password protection and that are currently acquiring data, the 
software alerts you that the device is acquiring data and gives you the option to abort 
acquisition and continue, or to cancel.

3. By default, the application "discovers" all devices that are available for the specified 
device family and displays their IP address (for Ethernet devices) or module name (for 
USB devices) in the drop-down list. If you want to refresh this list to determine if other 
devices are available, click Refresh. 
17
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Notes: OpenLayersDevices is the Device Family name for all Open Layers modules.

MEASURpoint-USB is the Device Family name for the USB versions of MEASURpoint, 
TEMPpoint, and VOLTpoint instruments. 

MEASURpoint-ENET is the Device Family name for all Ethernet versions of 
MEASURpoint, TEMPpoint, and VOLTpoint instruments.

DT8824 is the Device Family name for all DT8824 Series instrument modules.

DT8837 is the Device Family name for the DT8837 instrument module.

4. Select the IP address (for Ethernet devices) or module name (for USB devices) for the 
device that you want to use from the list of Available Devices, and click Add.
Information about the device, including the model number, serial number, firmware version, driver 
version, and scanning status is displayed.   

5. For Ethernet devices, if your supported device is not included in the list of available 
devices, but you want to manually connect to it, do the following:

a. Click Advanced.

b. Enter the IP address of the device that you want to connect to, and click OK. 
Information about the device, including the model number, serial number, firmware version, 
driver version, and scanning status is displayed.

c. From the Device Selection window, click Add.   

d. If the device supports password protection, the Password Required dialog box 
appears:
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e. If prompted, enter the password for the device. Refer to the user’s manual for your 
device to determine the default password. If desired, check the Mask password text 
checkbox so that you cannot read the password as it is being typed, and then click OK 
to continue. (Note that the software does not allow you to continue if you do not enter 
the appropriate password for the device.) 

Note: If the device that you want to add does not support password protection and the 
device is currently acquiring data, a warning dialog box appears notifying you that 
another application is using the device. You cannot continue with QuickDAQ until the 
device is not acquiring data.

If the device that you want to add supports password protection and the device is 
currently acquiring data, the software alerts you that the device is acquiring data and 
gives you the option to abort acquisition and continue, or to cancel.
19
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6. (Recommended) If you want to rename your device, do the following:

a. Click the Row Selector button for the device.

b. Click the IP address or module name in the Name column to highlight it and enter a 
meaningful name to represent each available device.   

7. (Optional) If you want to remove a device from list of selected devices, click the Row 
Selector button for the device, and then click Remove.

8. Once you have added all the devices that you want to use with the application, click OK. 
The latest state is saved and used when the application is next run, and QuickDAQ interface is 
displayed.   
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9. Configure the input channels of the device. (See page 56.)

10. Set up the parameters of the Recording tab in the Acquisition Config window. (See page 
81.)

11. Set up the parameters of the Acquisition tab in the Acquisition Config window. (See page 
84.)

12. Configure the display. (See Chapter 5 starting on page 87.)

13. To start acquisition, click the Record menu and then click Start, click the Record toolbar 
button (  ), or press the F5 key.
The results are displayed in the Channel Plot, Channel Display, and Statistics windows.
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Toolbar B
Overview of the Interface
Figure 1 shows the QuickDAQ interface. The interface includes menus, toolbar buttons, the 
configuration area, which includes the Acquisition Config window and the Plot and Data 
Config window, the display area, which includes the Channel Display window, Channel Plot 
window, and Statistics window, and the Acquisition Status window. 

Note: You can customize the look of the interface, as desired. However, if you want to revert 
to the default layout, select Windows from the list of menus and select Reset Window Layout 
to Default Layout.

Figure 1: QuickDAQ Interface

This chapter describes the major features of the interface.

uttons

Configuration Area

Display Area

Acquisition Status Window
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Menus
QuickDAQ provides the following menus at the top of the interface: File, Edit, Record, Plot, 
Configuration, Windows, and Help. 

File Menu

This section describes the options provided in the File menu.

New Hpf Data File 

When you click the New Hpf Data File option of the File menu or click the New HPF Data 
File toolbar button , you can create a new (empty) data file for use with QuickDAQ. You 
can name and save the data file, as desired. The format of this file is High Performance binary 
(.hpf). 

By default, the data file is stored in the following location:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

Note: To see the AppData folder, ensure that you set your view options to show hidden files. 
For example, in Windows 7, select Control Panel -> Appearance and Personalization -> 
Folder Options, select the View tab, and then select the Show hidden files, folders, and 
drives checkbox. Consult the documentation for your operating system for more 
information.

Open Hpf Data File 

When you click the Open Hpf Data File option of the File menu or click the Open HPF Data 
File toolbar button , you can open an .hpf data file that was created using QuickDAQ. 

A sample data file, called QuickDAQ Data.hpf, is provided, by default, in the following 
location:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data
25
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Close Hpf Data File 

The Close Hpf Data File option closes an opened data file (.hpf), restoring the previous state 
of QuickDAQ.

Export Data

When you click the Export Data menu option from the File menu, or click the Export Data 
toolbar button  , the following dialog box appears:

Configure this dialog as follows:

1. Under the Channels to Save area of the dialog, you can select whether to save the data 
from all channels or only those that are visible in the Channel Plot window or Channel 
Display window.

To save data from all channels, select All channels.

To save data from only the visible channels, select Visible channels only.

2. Under the Data Options area of the dialog, select which data to save.

You can save all scans by selecting Save all data, or save a subset of scans by selecting 
Save range of scans and entering the first scan and the last scan to save.
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3. Under the Output File Format area of the dialog, select the file format to use when 
exporting the data:

− Tab Delimited Text (.txt) – This file format is used by a number of applications, 
including Microsoft Excel. 

− Comma Delimited Text (.csv) – This file format is used by a number of applications, 
including Microsoft Excel.

4. If you wish, you can export information about the device and channels that correspond to 
the saved data, by selecting the Include device and channel info checkbox.

5. In the Output File Name text box, enter or browse to the name of the file that will contain 
the exported data.
The path showing where the file is located is shown.

If you want to append a number to this file name and increment the number 
automatically each time you export data, select the Auto-increment file name postfix # 
checkbox.

The default location for saving the data files is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

6. Click the Export button to export the data to the file you specified.

7. Once the file is created, you can open the file in Microsoft Excel by clicking the Open in 
Excel button.

8. When you are finished exporting the data, close this dialog box by clicking the Done 
button.

Save Current Plot Image

The Save Current Plot Image option saves the current plot image from the Channel Plot 
window to a file.

To save the image to a file, specify the name of the file and choose one of the extensions to save 
the file as a graphic. 

The default location for saving the current plot image files is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data
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Open Current Data in Excel 

If you choose the Open Current Data in Excel menu option from the File menu or click the 
Open Current Data in Excel toolbar button , the application opens a tab-separated 
(tmp.tvs) file in Microsoft Excel that contains all the time domain data for the visible channels 
in the Channel Plot window.

You can then perform further analysis of your data using Excel or other utilities. 

Note: Before using this option, ensure that Microsoft Excel is installed on your computer. In 
addition, you must stop acquisition before trying to use this option, or the application cannot 
open the file.

Load Configuration

The Load Configuration option opens an .XML file of stored configuration settings.

Save Configuration

The Save Configuration option saves the current application configuration to a user-specified 
filename with the .XML extension.

The default location for saving the configuration file is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Config.

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Config

Page Setup

The Page Setup option allows you to configure the page before you print it. Options are 
available for configuring the size, orientation, and margins of the page.

Print Preview

The Print Preview option allows you to preview the image from the Channel Plot window 
before you print it.

Print

The Print option prints the picture from the Channel Plot window to a printer.
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Exit

The Exit option closes QuickDAQ, and saves the current device configuration in the 
QuickDAQConfiguration.xml file in the default configuration folder. You can also close the 
application by clicking the  button in the top, right-hand side of the application.

Notes: A backup configuration file (QuickDAQConfiguration.xml.bak) is saved in the 
default configuration folder when QuickDAQ is exited. If, when starting QuickDAQ, an error 
occurs and the configuration file cannot be restored, the backup file is used to restore the 
configuration.

If the device is acquiring data through another application, a warning dialog box appears 
notifying you that you cannot save the current configuration if you close the application.

Exit without saving current configuration

The Exit without saving current configuration option closes QuickDAQ, but does not save 
the current device configuration.

Edit Menu

The Edit menu has the following menu options:

• Copy plot data to clipboard – Copies the data from the Channel Plot window to the 
Windows clipboard.

• Copy plot image to clipboard – Copies the image from the Channel Plot window to the 
Windows clipboard.

Record Menu

The Record menu has the following menu options:

• Start – Starts data acquisition on the device and logs the data to a High Performance 
binary file (.hpf). This is equivalent to clicking the Record button (  ) on the 
toolbar or pressing the F5 key. You can specify the name of the data file by opening a new 
Hpf file, described on page 25, or by using the Recording tab, described on page 81.

Note: You can use the scrollbar on the x-axis to pause tracking and scroll back through 
the data to the beginning of acquisition. Refer to page 44 and page 46 for more 
information on pausing and resuming tracking. 

For long duration acquisitions, ensure that your computer’s power options are set to 
never hibernate; refer to page 122 for more information.
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• Pause – Pauses recording. This is equivalent to clicking the Pause button ( ) on 
the toolbar or pressing the spacebar. To resume recording, click the Pause menu option, 
click the Pause button, or press the spacebar again.

• Stop – Stops the application from receiving data from the device. This is equivalent to 
clicking the Stop button (  ) on the main menu or holding down the Shift key 
and pressing the F5 key. You must stop acquisition to make configuration changes.

Plot Menu

The Plot menu has the following menu options:

• Plot Area Mouse Mode – You can select one of the following controls for the Channel Plot 
window:

− Select – Allows you to select items in the view area to zoom or to scroll. This is 
equivalent to using the Select control (  ) of the Channel Plot window, or holding 
down the Ctrl and Alt keys while pressing the V key.

− Zoom – Allows you to select a region in the view to magnify (zoom). This is equivalent 
to using the Zoom Box (  ) control of the Channel Plot window, or holding down 
the Ctrl and Alt keys while pressing the Z key.

Once in zoom mode, you can hold down the left mouse button, dragging the mouse to 
select the region that you want to magnify, and release the mouse button to magnify 
the area. The zoom action affects both axes.

− Cursor – Allows you to move the position of a data-cursor on the curve. This is 
equivalent to using the Data-Cursor ( ) control of the Channel Plot window, or 
holding down the Ctrl and Alt keys while pressing the C key.

Once in Data-Cursor mode, hold down the left mouse button and drag the mouse to 
move the data cursor. When the Data-Cursor is active, right-click the mouse to change 
the cursor style, line style, and/or color of the cursor; refer to page 48 for more 
information.

• Axis Mouse Mode – You can select one of the following controls for the axis:

− Scroll – Allows you to scroll through the axes. This is equivalent to using the Axes 
Scroll (  ) control of the Channel Plot window.

Once in this mode, hold down the left mouse button and drag the mouse over the axis 
(up and down for the y-axis, or right and left for the x-axis) to scroll through the axes.

− If you want to change the magnification (zoom) of the axes while this mode is selected, 
hold down the Ctrl button while holding down the left mouse button, and drag the 
mouse over the axis (up and down for the y-axis, or right and left for the x-axis).

− Zoom – Allows you to change the magnification (the zoom) of the axes. This is 
equivalent to using the Axes Zoom ( ) control of the Channel Plot window.

Once in this mode, you can change the magnification (the zoom) of the axes by holding 
down the left mouse button and dragging the mouse over the axis (up and down for 
the y-axis, or right and left for the x-axis). 
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Configuration Menu

The Configuration menu has the following menu options:

• Input Channel Configuration – When you click this menu option or click the Input 
Channel Configuration toolbar button (  ), the Configure Devices dialog box 
appears. Using this dialog box, you can specify which input channels are sampled, and 
configure the sensor type, engineering units, number of millivolts per engineering unit, 
and the test point number for each channel. 

Refer to page 56 for more information about configuring the channels of your device.

• Device Selection – Opens the Device Selection window, allowing you to select the devices 
for use with QuickDAQ in acquisition mode. Refer to page 17 for more information about 
using the Device Selection window.

Windows Menu

The Windows menu provides the following menu options:

• Acquisition Config window – Check this window option to show the Acquisition Config 
window. If this window option is unchecked, the Acquisition Config window is hidden. 
The Acquisition Config window allows you to configure the acquisition parameters of the 
data acquisition devices. Refer to Chapter 4 starting on page 55 for more information on 
this window.

• Plot and Data Config window – Check this window option to show the Plot and Data 
Config window. If this window option is unchecked, the Plot and Data Config window is 
hidden. The Plot and Data Config window allows you to configure the appearance of the 
display. Refer to Chapter 5 starting on page 87 for more information on this window.

• Channel Plot window – Check this window option to show the Channel Plot window. If 
this window option is unchecked, the Channel Plot window is hidden. This window 
allows you view the data from your device in a plot view. Refer to page 41 and page 94 for 
more information on this window.

• Channel Display window – Check this window option to show the Channel Display 
window. If this window option is unchecked, the Channel Display window is hidden. 
This window allows you view the data from your device in a digital display that 
resembles the front panel of the device. Refer to page 52 and page 88 for more information 
on this window.

• Channel Statistics window – Check this window option to show the Channel Statistics 
window. If this window option is unchecked, the Channel Statistics window is hidden. 
This window allows you view statistics about the data that you acquired. Refer to page 53 
for more information on this window.

• Reset Window Layout to Last Saved – Allows you to change the window layout to the 
last saved configuration.

• Reset Window Layout to Default Layout – Allows you to change the window layout to 
the default state. 
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Help Menu

The Help menu allows you to open this manual to describe the functionality of QuickDAQ, 
and get version information about the QuickDAQ application.

You can also open this manual using the Help toolbar button (  ).
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Toolbar Buttons
The following buttons are provided on the toolbar:

•  – New HPF Data File – Creates a new (empty) data file for use with QuickDAQ. This 
is equivalent to using the New Hpf Data file menu option under the File menu, described 
on page 25. 

You can name and save the data file, as desired. The format of this file is High 
Performance binary (.hpf). 

By default, the data file is stored in the following location:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

•  – Open HPF Data File – Opens an .hpf data file that was created using QuickDAQ. 
This is equivalent to using the Open Hpf Data file menu option under the File menu, 
described on page 25. 

A sample data file, called QuickDAQ Data.hpf, is provided, by default, in the following 
location:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

•  – Export Data – Opens the Export Data dialog box. This is equivalent to selecting the 
Export Data menu option of the File menu, described on page 26.

•  – Open Current Data in Excel – After you stop recording, you can click this button 
to open a tab-separated (tmp.tvs) file in Microsoft Excel that contains all the time domain 
data for the visible channels in the Channel Plot window. 

You can then perform further analysis of your data using Excel or other utilities. 

This is equivalent to selecting the Open Current Data in Excel menu option of the File 
menu, described on page 28.

Note: Before using this option, ensure that Microsoft Excel is installed on your computer. 
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•   – Record – Starts data acquisition on the device and logs the data to a High 
Performance binary (.hpf) file. This is equivalent to selecting the Start menu option of the 
Record menu or pressing the F5 key. You can specify the name of the data file using the 
Recording tab, described on page 81.

Note: You can use the scrollbar on the x-axis to pause tracking and scroll back through 
the data to the beginning of acquisition. Refer to page 44 and page 46 for more 
information on pausing and resuming tracking.

For long duration acquisitions, ensure that your computer’s power options are set to 
never hibernate; refer to page 122 for more information.

•  – Pause – Pauses recording. This is equivalent to selecting the Pause menu 
option of the Record menu or pressing the spacebar. To resume recording, click the Pause 
button, click the Pause menu option, or press the spacebar again.

•  – Stop – Stops acquisition. This is equivalent to the Stop menu option under the 
Record menu or holding down the Shift key and pressing the F5 key. You must stop 
acquisition to make configuration changes.

•  – Input Channel Configuration – Opens the Configure Devices dialog. This is 
equivalent to using the Input Channel Configuration menu option of the Configuration 
menu, described on page 31.

•  – Style – Allows you to configure the theme colors used by the application. You 
can select one of the following theme colors:

− Office 2010 Blue

− Office 2010 Silver

− Office 2010 Black

− Visual Studio 2010

− Windows 7

− Office 2007 Blue

− Office 2007 Black

− Office 2007 Silver

− Vista Glass

− Custom Scheme – Allows you to select your own color scheme to use for the 
application.

•  – Help – Opens the this manual to describe QuickDAQ. This is equivalent to clicking 
the User’s Manual menu option of the Help menu, described on page 32.
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Window Positioning
The configuration area of the interface contains the Acquisition Config and the Plot and Data 
Config windows. The display area of the interface contains the Channel Plot, Channel Display, 
and Channel Statistics windows. The Acquisition Status window is located under the Channel 
Plot, Channel Display, and Statistics windows.

This section describes how to move, resize, dock, and hide windows in the interface. The 
remaining sections of this document describe each window in more detail.

Moving, Resizing, and Docking Windows

Note: The Acquisition Status window is docked automatically. You cannot undock the 
Acquisition Status window.

You can move a window anywhere on the desktop by clicking the title bar or tab of the 
window and, while holding down the mouse button, dragging the window to the location 
you want. When you release the mouse button, this "floating" window remains in the location 
that you selected.

You can resize a window by clicking on any of the outside edges of the window and, while 
holding down the mouse button, dragging the window to the desired size. When you release 
the mouse, the window is scaled automatically.

You can also dock a window by doing the following:

1. Click the title bar or tab of the window.

2. Drag the window to where you want to dock it.
A guide diamond appears. 

For windows in the configuration area, the four guides on the outside of the diamond represent the 
four sides of the configuration area. The center square docks the tabbed window in the 
configuration area. Additional guides are provided when you move the windows in the 
configuration area, allowing you to dock the window to the left side of the configuration area or to 
the right or left side of the display area.

For windows in the display area, the four guides on the outside of the diamond represent the four 
sides of the display area. The center square docks the tabbed window in the display area.
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3. Move the pointer over the corresponding portion of the guide (the designated area is 
shaded), and release the mouse.

For example, if you want to dock the Acquisition Config window to the left side of the 
configuration area, drag the Acquisition Config window toward the middle of the 
configuration area, move the pointer over the guide on the far left, and then release the mouse 
button.

Notes: To return a window in the display area to its most recent docked location, press CTRL 
while you double-click the title bar of the window.

To dock/undock a window in the configuration area, press CTRL while you double-click the 
title bar of the window.

Hiding a Window

For all windows, except the Acquisition Status window, you can hide the window by clicking 
the "X" at the top, right corner of the window. To show the window again, click the Windows 
menu, and the check the name of the window to show. Any window name that is not checked 
under the Windows menu is hidden. 

You can hide the Acquisition Status window and the windows in the configuration area, if 
desired, by clicking the Auto-Hide pin (  ) in the top, right corner of the window. When 
the window is hidden, a tab for the window is created; the size of the display area is increased. 
When the window is shown, the size of the display area is decreased. To see the window 
again, hover over the tab for the window. Click the Auto-Hide pin again to display the 
window.

Move the pointer over this guide to 
dock the window to the top of the 

selected area.

Move the pointer over this guide to 
dock the window to the right of the 

selected area.

Move the pointer over this guide to 
dock the window to the bottom of the 

selected area.

Move the pointer over this guide to 
dock the window to the left of the 

selected area.

For windows in the configuration area, move the 
pointer over this guide to dock the tabbed window 

in the configuration area.

For windows in the display area, move the pointer 
over this guide to dock the tabbed window in the 

default location in the display area.
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Resetting the Window Layout

If you want to reset the windows to their default view, select the Windows menu, and select 
Reset Window Layout to Default Layout. 

You can also reset the display area to its last saved configuration by selecting the Windows 
menu, and selecting Reset Window Layout to Last Saved.
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Acquisition Config Window
The Acquisition Config window provides the following tabs for configuring recording and 
acquisition settings used by the device:

• Recording tab – This tab allows you to set up the file name for the data file, enable or 
disable continuous acquisition, and to specify the acquisition duration and x-axis span. 

Refer to page 81 for more information about using this tab to configure the recording 
settings.
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• Acquisition tab – This tab allows you to set up the parameters that apply to the analog 
input subsystem, including the per channel sampling frequency of the device, the trigger 
source that starts the acquisition, the channel configuration (single-ended or differential), 
input voltage range, the temperature units to use when converting voltage data to 
temperature, and/or the filter type. Refer to page 83 for more information about using this 
tab to configure the acquisition settings.

Based on the information you set, the current sample rate, sample interval, and number of 
scans used by the device are displayed.
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Plot and Data Config Window
The Plot and Data Config window allows you to select which channels you want to plot and 
specify the appearance of the display area. (Refer to Chapter 5 for information about how to 
configure the settings of the Plot and Data Config window.)
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Channel Plot Window
You can access the Channel Plot window by clicking the Channel Plot tab in the display area 
of the interface or by clicking the Channel Plot menu option under the Windows menu.

During acquisition, the results are plotted in the Channel Plot window in real time. In 
file-reader mode, the results are read from the file and plotted in the Channel Plot window.

The following sections describe how to set up the scaling for the y- and x-axes on the Channel 
Plot window, how to use the scrolling options for the Channel Plot window, and how to use 
the controls provided for the Channel Plot window. Refer to Chapter 5 starting on page 87 for 
more information about the Channel Plot window.
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Setting Up the Y-Axis

If you right-click on the y-axis, the following dialog box is displayed:

These options are described below.

Y Axis Setup

If you select Y Axis Setup, the following dialog appears:

You can set up the following parameters for the y-axis:

• Gridlines – Select Show Minor if you want to display the minor gridlines on the y-axis; 
select Show Major if you want to display the major gridlines on the y-axis.

• Scaling – Select Autoscale if you want the application to determine the scale of the y-axis 
automatically. If you want to specify the scale of the y-axis, select Manual and then enter 
the minimum and maximum values for the y-axis.

• Precision – You can select the number of significant digits after the decimal point to 
display on the y-axis and in the cursor text; values range from 1 to 8 (2 is the default).
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• Format – You can change for the format of the axis to see either the actual Number (such 
as 200) or the number in Exponent form (such as 2.0e+002).

• Lin/Log – If Linear scaling is selected for the channel, you can change the axis of the 
plotted data to either Linear or Log10. 

Zoom to Fit in View

Select this menu option to scale the y-axis for the selected channel to the minimum and 
maximum values of the actual input signal(s) that are in the current view.

Zoom to Fit All

Select this menu option to scale the y-axis for the selected channel to the minimum and 
maximum values of the actual input signal(s) that were acquired, regardless of whether the 
data is in the current view.

Setting Up the X-Axis

If you right-click on the x-axis, the following dialog box is displayed:
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X Axis Setup

If you select X Axis Setup, the following dialog appears:

You can set up the following parameters for the x-axis:

• Gridlines – Select Show Minor if you want to display the minor gridlines on the y-axis; 
select Show Major if you want to display the major gridlines on the y-axis.

• Scaling – Specify the scale of the x-axis by entering the minimum and maximum values 
for the x-axis.

Any options that are grayed out do not apply to this application.

Zoom to Fit All

Select this menu option to scale the x-axis for the selected channel to the minimum and 
maximum values of the actual input signal(s) that were acquired.

Edit Label

Select this menu option to change the text that is displayed for the x-axis.

Pause Tracking

If the application is recording, you can click this popup menu option to pause tracking for a 
specific plot. The plot stops updating, but data is still recorded to disk. The tracking for other 
plots is unaffected by this action.
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A specific plot can also be paused by using the scrollbar for the x-axis to scroll through the 
data. After tracking is paused, the scrollbar continues to be updated so that you can scroll to 
the data as it is being acquired.

If you want to pause tracking for all channels, use the Tracking Pause  button on the 
toolbar instead. Refer to page 46 for more information.

While tracking is paused, you can use the controls for the Channel Plot window, described on 
page 46, to analyze the data that was previously recorded.

Resume Tracking

If recording is still in progress, you can resume tracking for a specific plot by clicking the 
Resume Tracking popup menu option. The tracking for other plots is unaffected.

To resume tracking for all plots whose tracking was paused, click the Tracking Resume  
button on the toolbar. Refer to page 46 for more information.

Scrolling Options

If you right-click on the scrollbar of the x-axis, the following dialog box is displayed:

The options are as follows:

• Scroll Here – Moves the scroll bar to the point of the mouse click that opened the scroll 
bar dialog.

• Left Edge – Moves the scroll bar to the left edge of the acquired data.

• Right Edge – Moves the scroll bar to the right edge of the acquired data.

• Page Left – Updates the content of the scroll area with the page of data to the left of the 
data is currently being displayed.

• Page Right – Updates the content of the scroll area with the page of data to the right of the 
data is currently being displayed.

• Scroll Left – Scrolls to the left.

• Scroll Right – Scrolls to the right.
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Using the Channel Plot Window Controls

A toolbar, shown in Figure 2, provides a number of controls for the Channel Plot window.

Figure 2: Toolbar of the Channel Plot Window

Tracking Resume 

If the application is recording and tracking was paused, you can click this button to resume 
tracking for all plots on the display. The display is then updated with the current data in real 
time.

To resume tracking on a specific plot rather than on all plots, right-click the x-axis and select 
the Resume Tracking popup menu option; refer to page 45 for more information.

Tracking Pause 

If the application is recording, you can click this button to pause tracking on all plots of the 
display. The display stops updating, but data is still recorded to disk. While tracking is paused 
you can use the other controls to analyze the data that was previously recorded.

To pause tracking on a specific plot rather than on all plots, right-click the x-axis and select the 
Pause Tracking popup menu option or use x-axis scrollbar to scroll through the data; refer to 
page 44.

Axes Scroll 

When you click this button, you can scroll through the axes by holding down the left mouse 
button and dragging the mouse over the axis (up and down for the y-axis, or right and left for 
the x-axis).

If you want to change the magnification (zoom) of the axes while this button is selected, hold 
down the Ctrl button while holding down the left mouse button, and drag the mouse over the 
axis (up and down for the y-axis, or right and left for the x-axis).

When this button is selected, the Axes Zoom button is unselected.

Axes Zoom 

When you click this button, you can change the magnification (the zoom) of the axes by 
holding down the left mouse button and dragging the mouse over the axis (up and down for 
the y-axis, or right and left for the x-axis). 

When this button is selected, the Axes Scroll button is unselected.
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Zoom-Out All 

When you click this button, the magnification of all axes is reduced (zoomed out) by a factor 
of 2.

Zoom-In All  

When you click this button, all axes are magnified (zoomed in) by a factor of 2.

Zoom All to Fit in View Y 

When you click this button, the scale of all y-axes are adjusted to the minimum and maximum 
values of the actual input signal(s).

Link X Axes to Selected 

Click the x-axis for the plot that you want to link to, then click the Link X Axes button to link 
all x-axes of the data. You can then use the scrolling controls to affect the view of all the x-axes 
of all the data at the same time.

Link Y Axes to Selected 

Click the y-axis for the plot that you want to link to, then click the Link Y Axes button to link 
all y-axes of the data. You can then use the scrolling controls to affect the view of all the y-axes 
of all data at the same time.

Link Cursors to Selected   

Locks data cursors together so that by moving the locked data cursor, all the data cursors 
move together. To use this button, click the Data-Cursor button, click the data cursor that you 
want to lock to, and then click the Link Cursors to Selected button. Once it is locked, moving 
the locked data cursor moves all the data cursors. 

Select 

When you click this button, you can select items in the view area to zoom or scroll. This is 
equivalent to holding down the Ctrl and Alt keys while pressing the V key, or selecting the 
Plot menu, selecting Plot Area Mouse Mode, and choosing the Select menu option.

Zoom Box 

When you click this button, you can select a region in the view to magnify (zoom) by holding 
down the left mouse button, dragging the mouse to select the region that you want to magnify, 
and releasing the mouse button. The zoom action affects both axes.

This is equivalent to holding down the Ctrl and Alt keys while pressing the Z key, or selecting 
the Plot menu, selecting Plot Area Mouse Mode, and choosing the Zoom menu option.
47



Chapter 3

48
Data-Cursor 

When you click this button, you can move the position of a data-cursor on the curve by 
holding down the left mouse button and dragging the mouse. 

This is equivalent to holding down the Ctrl and Alt keys while pressing the C key, or selecting 
the Plot menu, selecting Plot Area Mouse Mode, and choosing the Cursor menu option.

When the Data-Cursor is active, right-click the mouse to change the cursor style, line style, 
and/or color of the cursor; the following menu appears:

You can change the cursor style to one of the following settings:

• Value-XY – Choose this style to display a single value at a particular point on the X- and 
Y-axes.

• Period – Choose this style to display the period, in seconds, between two vertical cursors. 
You can drag each cursor independently.

• Frequency – Choose this style to display the frequency, in Hertz, between two vertical 
cursors. You can drag each cursor independently.

• Peak-Peak – Choose this style to display the value between two horizontal cursors. This is 
the number of volts or sensor units. You can drag each cursor independently.

The following example shows a period data cursor, where two data cursors show the period, 
in seconds, between two data points:
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You can change the line style to one of the following settings:

• Solid – Choose this style to display the cursors as solid lines.

• Dash – Choose this style to display the cursors as a dashed lines.

• Dot – Choose this style to display the cursors as a dotted lines.

• DashDot – Choose this style to display the cursors as lines of dash-dot elements.

You can change the color of the cursors to one of the provided basic colors or to any custom 
color you desire.

Copy to Clipboard 

When you click this button, you can copy either the graph (the picture) or the data that is 
displayed in the Channel Plot window to the clipboard.

Save Plot Image 

When you click this button, you can save the image from the Channel Plot window to a file. 
Specify the name of the file and choose one of the extensions to save the file as a graphic. 

The default location for saving the image files is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data.

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\Data 
Translation\QuickDAQ\Data

Print 

When you click this button, you can print the picture from the Channel Plot window to a 
printer.

Preview 

When you click this button, you can preview the image from the Channel Plot window before 
you print it.

Page Setup 

When you click this button, you can configure the page before you print it. Options are 
available for configuring the size, orientation, and margins of the page.
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Show Legend 

When you click this button, you can show or hide the legend that defines the colors used for 
each channel on the plot. An example follows:   

Show Data Point Markers 

When you click this button, you can show or hide markers that indicate the actual samples on 
the curve, as shown in the following example. The diamond markers indicate the actual 
samples. 

If you click on a data point marker, a label for the channel is displayed. 

Note: When moving the data-cursor with the data point markers shown, the data-cursor 
snaps to the closest sample on the curve. 
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Channel Display Window
You can access the Channel Display window by clicking the Channel Display tab in the 
display area of the interface or by clicking the Channel Display menu option under the 
Windows menu.

During acquisition, the newest value for each enabled channel is displayed in the Channel 
Display window in real time. The Channel Display window allows you to view data from 
your device in a digital display. By default, the layout represents the channel locations on the 
front panel of the device. Refer to Chapter 5 starting on page 87 for more information about 
the Channel Display window.
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Statistics Window
You can access the Statistics window by clicking the Statistics tab in the display area of the 
interface or by clicking the Channel Statistics menu option under the Windows menu.

During acquisition, the statistics are displayed in the Statistics window in real time, providing 
that the channel statistics were made visible in the Plot and Data Config window, described on 
page 105. The Statistics window shows the minimum, maximum, and mean values of the data, 
along with the standard deviation for each enabled channel.
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Acquisition Status Window
The Acquisition Status window, located under the Channel Plot, Channel Display, and 
Statistics windows, shows the status of the device.
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Configuring Channels of a Device

Notes: To configure the channels, you must have selected a supported device or have opened 
an .hpf file that contains configuration settings for a supported device. 

If acquisition is in progress, you must choose Stop from the Record menu or click the Stop 
toolbar button (  ) before you can change the configuration of a device.

Choose the Input Channel Configuration toolbar button (  ) or the Input Channel 
Configuration from the Configuration menu to configure the channels from which to acquire 
data in the analog input data stream. The Configure Devices dialog appears. 

The elements of the Configure Devices dialog depend on the specified device. For example, 
the Configure Devices dialog for a MEASURpoint instrument appears as follows:

Figure 3: Example Configuration of a MEASURpoint Instrument
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In contrast, the Configure Devices dialog for a DT9836 module appears as follows:

Figure 4: Example Configuration of a DT9836 Module
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Enabling Channels

Select the channels that you want to enable for acquisition by clicking the checkbox under the 
Enable column. Only data from the enabled channels is included in the analog input data 
stream.

Note: For the DT9805 and DT9806 modules, the CJC channel is enabled automatically if any 
of the analog input channels are configured for a temperature sensor type. You can disable 
this channel, if desired.

If you want to enable all the channels at once, click the Multi-channel Actions button
(  ) and then click Enable all Channels. If you want to enable several but not 
all channels at once, highlight the channels that you want to enable, click the Multi-channel 
Actions button, and then click Enable all Selected Channels.

If you want to disable all the channels at once, select the Multi-channel Actions button, and 
then click Disable all Channels. If you want to disable several but not all channels at once, 
highlight the channels that you want to disable, click the Multi-channel Actions button, and 
then click Disable all Selected Channels.

Channel Name

For each channel, you can specify a meaningful name for each channel, if desired, by 
highlighting the channel under the Channel Name column and entering a new name.

Analog Input Channel Settings for Devices that Support 
Temperature and/or Multi-Range Voltage Inputs

This section describes the analog input settings that you can configure for devices, such as the 
MEASURpoint instruments and DT9805/DT9806 modules, that support temperature and/or 
multi-range voltage input channels.

Sensor Type

Select the type of sensor that is connected to each channel under Sensor Type column. Values 
are as follows:

For devices that support thermocouple input types for each channel:

• Type B 

• Type E 

• Type J 

• Type K

• Type N
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• Type R 

• Type S 

• Type T 

• Volts

If you want to specify the same thermocouple type for all channels, click the Multi-channel 
Actions button (  ), select Set all Thermocouple Channels, and select the 
specific thermocouple type.

For devices that support RTD input types for each channel:

• Euro PT1000 (for 2- and 4-wire RTDs)

• Euro PT500 (for 2- and 4-wire RTDs)

• Euro PT100 (for 2- and 4-wire RTDs)

• American PT1000 (for 2- and 4-wire RTDs)

• American PT500 (for 2- and 4-wire RTDs)

• American PT100 (for 2- and 4-wire RTDs)

• Euro PT1000 3 Wire (for 3-wire RTDs)

• Euro PT500 3 Wire (for 3-wire RTDs)

• Euro PT100 3 Wire (for 3-wire RTDs)

• American PT1000 3 Wire (for 3-wire RTDs)

• American PT500 3 Wire (for 3-wire RTDs)

• American PT100 3 Wire (for 3-wire RTDs)

• Ohms

• Volts

If you want to specify the same RTD type for all channels, click the Multi-channel Actions 
button (  ), select Set all RTD Channels, and select the specific RTD type.

For devices that support multi-range voltage inputs per channel:

• ±10 V, ±100 V, or ±400 V for DT8874, DT9847, DT8873, and DT9873 instruments

• ±10 V, ±100 V, or ±600 V for DT8875 instruments

• ±100 mV, ±1.0 V, or ±10 V for DT8876 instruments

• ±10 V, ±1.25 V, ±0.625 V, or ±0.3125 V for DT8824 instrument modules

• ±600 V, ±75 V, ±37.5 V, or ±18.75 V for DT8824-HV instrument modules

If you want to specify the same voltage range for all multi-range channels, click the 
Multi-channel Actions button (  ), select Set all Multi-Range Channels, and 
select the specific voltage range.

Check the user’s manual for your device for more information on supported sensor types.
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Range

If supported, set the input range for each analog input channel. 

Engineering Unit (EU)

Depending on the sensor that is connected to each analog input channel, you can select the 
following engineering units:

• For channels that are configured for thermocouple or RTD inputs, the data is returned in 
Deg C, Deg F, or Deg K. Note that you determine whether the data is returned in degrees 
C, degrees F, or degrees K using the Acquisition tab, described on page 84.

• For voltage inputs, you can choose from one of the following engineering units to display 
the data, based on the sensor that is attached to the channel:

If you select Custom, you can define your own engineering units.

If you want to specify the same engineering units for all voltage channels, click the 
Multi-channel Actions button (  ), select Set all Voltage Channel Units, and 
select the specific engineering units to use from the list above.

If you want to set the engineering units for some but not all analog input channels at once, 
select the Multi-channel Actions button, click Set all Selected Channel Units, and select the 
desired engineering units.

mV/EU

If the sensor type is Volts, you can enter the number of millivolts per engineering 
unit (mV/EU) by which to scale the raw voltage based on the engineering units that you 
selected.

EU Offset

You can enter an offset (EU Offset) value to add to the scaled signal.
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Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.

Analog Input Channel Settings that Support IEPE Inputs

This section describes the settings that you can configure for devices, such as the DT8837, 
DT9837 Series, and DT9847 Series devices, that support IEPE inputs on the analog input 
channels.

Range

Set the input range for each analog input channel. 

Coupling Type

Select AC (AC coupling) to remove any DC offset from your measurement, or select DC (DC 
coupling) if the signal source has no offset voltage or if the DC content of the acquired signal is 
important. Most IEPE input signals require AC coupling. 

If you want to set the coupling type for all analog input channels at once, select the 
multi-channel Actions button (  ), click Set all Channel Coupling, and select 
either AC or DC.

Current Source

Enable use of the 4 mA current source by checking the Current Source checkbox, or disable 
use of the 4 mA current source by unchecking the Current Source checkbox. Most IEPE input 
signals require use of the current source.

If you want to set the current source for all analog input channels at once, select the 
multi-channel Actions button (  ), click Set all Channel Current Source, and 
select either Enabled or Disabled.

Engineering Unit (EU)

You can choose from one of the following engineering units to represent the data, based on the 
sensor that is attached to the channel:
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If you select Custom, you can define your own engineering units.

If you want to set the engineering units for all analog input channels at once, select the 
Multi-channel Actions button(  ), click Set all Channel Units, and select the 
desired engineering units.

If you want to set the engineering units for some but not all analog input channels at once, 
select the Multi-channel Actions button(  ), click Set all Selected Channel 
Units, and select the desired engineering units.

mV/EU

Depending on the engineering units that you selected, you can enter the number of millivolts 
per engineering unit (mV/EU) by which to scale the raw voltage.

EU Offset

Depending on the engineering units that you selected, you can enter an offset (EU Offset) 
value to add to the scaled signal.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.

Dir

Specify one of the following sensor directions for the analog input channel, if desired: X+, X-, 
Y+, Y-, Z+, Z-, or Scalar (no direction).

Analog Input Channel Settings for Devices that Support Voltage

This section describes the settings that you can configure for the analog input channels on 
your device.
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Engineering Unit (EU)

For voltage inputs, you can choose from one of the following engineering units to display the 
data, based on the sensor that is attached to the channel:

If you select Custom, you can define your own engineering units.

If you want to specify the same engineering units for all voltage channels, click the 
Multi-channel Actions button (  ), select Set all Voltage Channel Units, and 
select the specific engineering units to use from the list above.

If you want to set the engineering units for some but not all analog input channels at once, 
select the Multi-channel Actions button, click Set all Selected Channel Units, and select the 
desired engineering units.

mV/EU

Enter the number of millivolts per engineering unit (mV/EU) by which to scale the raw 
voltage based on the engineering units that you selected.

EU Offset

You can enter an offset (EU Offset) value to add to the scaled signal.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.

Analog Input Channel Settings for Devices that Support Strain

This section describes the settings that you can configure for the analog input channels on 
devices, such as the DT9838, that support strain.
63



Chapter 4

64
Enable Shunt Resistor

For quick verification of your wiring, you can enable the internal shunt resistor, acquire data, 
and then verify that you are measuring the value that you expect from your strain gage. (Be 
sure to disable the shunt resistor after you have verified your wiring.) 

Note that this use of the shunt resistor is different from the use of the shunt resistor when 
performing shunt calibration. Shunt calibration is done using the Configuration and 
Calibration wizard, described next. During shunt calibration, the software automatically 
enables the shunt resistor for the calibration procedure and disables it once calibration has 
been performed. 

Configuration and Calibration Wizard

You can use the Configuration and Calibration wizard to set up the parameters for the strain 
gage or bridge-based sensor and, if desired, calibrate it.

When you click the Configure and Calibrate button, a screen similar to the following is 
displayed:

Select the type of sensor that is connected to the selected channel. The following choices are 
available:
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• Full Bridge Based Sensor – for load cells, pressure transducers, torque transducers, and 
other bridge-based sensors

• Strain Gage – for strain gage sensors

• Voltage Based Sensor – for voltage inputs or non-strain gage inputs

If your bridge-based sensor or strain gage supports TEDS (Transducer Electronic Data Sheet) 
data in hardware, the LED on this screen turns green. Click the Apply TEDs Values button to 
apply the TEDS data to the channel configuration.

If your sensor does not support TEDS data in hardware, the LED on this screen turns red. If a 
TEDS data file (virtual TEDS) is available for your sensor, click the Open TEDs data file.... 
button, select the TEDS data file to read, and click Open. The TEDS values are applied to the 
channel configuration.

Click Next to continue to the next page of the wizard.

Parameters for Full Bridge Based Sensors

If you select Full Bridge Based Sensor as your sensor type, a screen similar to the following 
appears:
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If you applied TEDS values from the sensor hardware or data file, the TEDS values are 
displayed in the fields on this screen.

You can configure the following parameters:

• Transducer Rated Output – Specify the rated output of the transducer in terms of mV/V 
excitation.

• Transducer Capacity – Specify the full-scale range of the transducer in its native 
engineering units.

• Using Sense Lines – For the selected analog input channel, enter Yes if remote sense lines 
are used or No if remote sense lines are not used in the wiring of the strain gage to the 
device.

The wiring diagram changes depending on this selection. To see the wiring diagram of the 
strain gage to the device, click the  button.

• Lead Wire Resistance – For the selected analog input channel, specify the lead wire 
resistance, in ohms. Note that if remote sense lines are used, then this value is set to 0 
automatically.

• Excitation Voltage – Specify the value of the excitation voltage that will be applied to all 
analog input channels on the device.

• Nominal Gage – For the selected analog input channel, enter the nominal gage resistance, 
in ohms, that is specified by the manufacturer of the sensor.

• Unit – For the selected analog input channel, select one of the following engineering units 
to represent the data, based on the sensor that is attached to the channel:

If you select Custom, you can define your own engineering units.

Click Next to continue to the calibration page of the wizard. A screen similar to the following 
appears:
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A balanced bridge produces zero volts under ideal conditions with zero strain applied. In 
practice, however, the output of a bridge in an unstrained condition is offset from zero slightly 
due to imperfect matching of bridge resistances.

You can adjust the offset of the channel by performing offset nulling on the channel. To 
perform offset nulling, select the Offset Nulling checkbox, click Next, and then click 
Calibrate. Internally, this value is subtracted from all subsequent measurements before the 
voltage is converted to the selected engineering units. Note that you wish, you can reset the 
value by clicking the Reset button. 

You can use shunt calibration to correct span errors in the measurement path. To perform 
shunt calibration, select the Shunt Calibration checkbox, and click Next. A screen similar to 
the following appears:
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If you want to enter a value rather than use a shunt resistor to perform the shunt calibration 
procedure, select Physical Value as the Calibration Type. The page changes to allow you to 
enter a value. Enter the physical value to apply to the bridge, and click the Calibrate button.

To use the internal shunt calibration resistor provided by the device to perform shunt 
calibration, do the following:

1. Select Shunt Resistor as the Calibration Type.

2. Select Internal for the Select Resistor Source combo box.

3. Ensure that the internal RSHUNT+ and RSHUNT– lines are connected across the gage 
and that no strain is applied to the specimen. (The internal shunt resistor is automatically 
enabled for this procedure and automatically disabled when the shunt calibration 
procedure is complete.) 

4. For the Select Node to Shunt combo box, select the node (R1 to R4) that you want to 
shunt.

5. Click the Calibrate button.
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If you want to use an external shunt calibration resistor to perform shunt calibration, do the 
following:

1. Select Shunt Resistor as the Calibration Type.

2. Select External for the Select Resistor Source combo box.

3. Ensure that the external shunt resistor is connected across the gage, and that no strain is 
applied to the specimen. 

4. For the Select Node to Shunt combo box, select the node (R1 to R4) that you want to 
shunt.

5. Click the Calibrate button.

The calculated value, measured value, and correction coefficient are displayed. Note that you 
wish, you can reset the values by clicking the Reset button.

Click Finish when you are done using the wizard.

Parameters for Strain Gage Sensors

If you select a Strain Gage sensor, a screen similar to the following appears:
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If you applied TEDS values from the sensor hardware or data file, the TEDS values are 
displayed in the fields on this screen.

You can configure the following parameters:

• Bridge Type – Select one of the following bridge configurations for each analog input 
channel; refer to the user’s manual for your device for more information about each of 
these configuration types:

− Quarter Bridge 

− Quarter Bridge Temp Comp 

− Full Bridge Axial Poisson

− Full Bridge Bending 

− Full Bridge Bending Poisson 

− Half Bridge Bending 

− Half Bridge Poisson 

A circuit diagram is shown for the selected configuration type. To see how to wire the 
strain gage to the device, click the  button.

• Excitation Voltage – Specify the value of the excitation voltage that will be applied to all 
analog input channels on the device.

• Nominal Gage – For the selected analog input channel, enter the nominal gage resistance, 
in ohms, that is specified by the manufacturer of the strain gage.

• Gage Factor – For the selected analog input channel, enter the gage factor that is specified 
by the manufacturer of the strain gage.

• Using Sense Lines – For the selected analog input channel, enter Yes if remote sense lines 
are used or No if remote sense lines are not used in the wiring of the strain gage to the 
device.

The wiring diagram changes depending on this selection. To see the wiring diagram of the 
strain gage to the device, click the  button.

• Lead Wire Resistance – For the selected analog input channel, specify the lead wire 
resistance, in ohms. Note that if remote sense lines are used, then this value is set to 0 
automatically.

• Min Range – For the selected analog input channel, specify the minimum strain value for 
the range.

• Max Range – For the selected analog input channel, specify the maximum strain value for 
the range.

• Unit – For the selected analog input channel, select one of the following engineering units 
to represent the data, based on the sensor that is attached to the channel:
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If you select Custom, you can define your own engineering units.

• Poisson Ratio – Depending on the bridge type, specify the Poisson ratio for each analog 
input channel. If you click the  button, the following Poisson ratios are displayed for 
various materials:

Click Next to continue to the calibration page of the wizard. A screen similar to the following 
appears:
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A balanced bridge produces zero volts under ideal conditions with zero strain applied. In 
practice, however, the output of a bridge in an unstrained condition is offset from zero slightly 
due to imperfect matching of bridge resistances.

You can adjust the offset of the channel by performing offset nulling on the channel. To 
perform offset nulling, select the Offset Nulling checkbox, and click Next. A screen similar to 
the following appears:
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Click Calibrate. Internally, the calibrated offset is subtracted from all subsequent 
measurements before the voltage is converted to strain. Note that you wish, you can reset the 
value by clicking the Reset button. 

You can use shunt calibration to correct span errors in the measurement path. To perform 
shunt calibration, select the Shunt Calibration checkbox, and click Next. A screen similar to 
the following appears:
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If you want to use the internal shunt calibration resistor provided by the device, select 
Internal for the Select Resistor Source combo box, ensure that the internal RSHUNT+ and 
RSHUNT– lines are connected across the gage, and that no strain is applied to the specimen. 
(The internal shunt resistor is automatically enabled for this procedure and automatically 
disabled when the shunt calibration procedure is complete.) Then, for the Select Node to 
Shunt combo box, select the node that you want to shunt (the values depend on the bridge 
type that you selected). 

If you want to use a user- supplied external shunt calibration resistor, select External for the 
Select Resistor Source combo box, ensure that the external shunt resistor is connected across 
the gage, and that no strain is applied to the specimen. Then, for the Select Node to Shunt 
combo box, select the node that you want to shunt (the values depend on the bridge type that 
you selected).

Once the shunt calibration parameters have been configured, click Calibrate. The calculated 
value, measured value, and correction coefficient are displayed. Note that you wish, you can 
reset the values by clicking the Reset button.

Click Finish when you are done using the wizard.
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Parameters for Voltage Based Sensors

If you select Voltage Based Sensor as your sensor type, a screen similar to the following 
appears:

You can configure the following parameters:

• Unit – You can choose from one of the following engineering units to represent the data, 
based on the input that is attached to the channel:
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If you select Custom, you can define your own engineering units.

• Sensor Scaling – Depending on the engineering units that you select, you can enter the 
number of millivolts per engineering unit (mV/EU) by which to scale the raw voltage.

• Sensor Offset – Depending on the engineering units that you select, you can enter an 
offset value to add to the scaled signal.

Click Finish when you are done using the wizard.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.

Tachometer Settings

This section describes the settings that you can configure for tachometer channels that are 
supported in the analog input data stream.

Engineering Unit (EU)

For each tachometer channel, you can choose from one of the following engineering units to 
plot the data:

• RPM – Choose RPM if you want to plot the data from the tachometer in RPMs.

• Sec – Choose Sec if you want to plot the data from the tachometer in seconds.

• Hz – Choose Hz if you want to plot the data from the tachometer in Hertz.

Ticks/Rev

When you select RPM as the engineering unit for the tachometer, enter the number of ticks 
per revolution for your particular tachometer in the Ticks/Rev field. This allows the 
application to calibrate to the characteristics of your tachometer.

Max RPM

When you select RPM as the engineering unit for the tachometer, enter the maximum number 
of revolutions per minute for your particular tachometer in the Max RPM field.

This allows the application to calibrate to the characteristics of your tachometer. 

RPM Multiplier

When you select RPM as the engineering unit for the tachometer, you can enter a value in the 
RPM Multiplier field to convert RPM into other units, such as Miles per Hour, Revolutions 
Per Second, or Hz. For example, to multiply by a factor of 2, enter 2 in the RPM Multiplier 
field. To divide by 2, enter a value of 0.5 in the RPM Multiplier field.
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Max mSec/Hz

When you select Sec or Hz for the engineering units of the tachometer, you can enter the 
maximum value for the Y-axis in the Max mSec/Hz field.

Tach Edge

On the DT9837, the period of the tachometer input signal is not programmable; it is always 
measured from rising-to-rising edge. For other devices, select which period of the tachometer 
input signal to measure:

• Rising – Measures from the rising-to-rising edge of the tachometer input signal.

• Falling – Measures from the falling-to-falling edge of the tachometer input signal.

Note: Old tachometer values (from a previous tachometer operation) may be in the data 
stream until two tachometer edges of the specified type are detected.

Counter Settings

This section describes the settings that you can configure for counters that are supported in 
the analog input data stream.

Note that counters may be used differently depending on the device. For example, Table 1 
describes how the counters are used the DT9837 Series devices. Refer to the documentation for 
your device for information on the counters provided by your device.

Table 1: Use of Counter 1 and Counter 2 on Each Device 

Device Counter 1 (Tach Counter) Counter 2 (Gate Counter)

DT8837 Measure the frequency, period, or phase 
between two specified signals.

Measure the frequency, period, or phase 
between two specified signals.

DT9837 Not supported. Not supported.

DT9837A Measures the phase of the tachometer 
signal.

Not accessible on the device.

DT9837A-OEM Measures the phase of the tachometer 
signal.

Measures the pulse width of the gate 
input signal or the phase between the 
gate signal and the A/D completion signal.

DT9837B Measures the phase of the tachometer 
signal.

Measures the pulse width of the gate 
input signal or the phase between the 
gate signal and the A/D completion signal.

DT9837C Not supported. Not supported.

DT9838 Measure the frequency or period of the 
tachometer input signal.

Not supported.
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Engineering Unit (EU)

For each counter, you can choose from one of the following engineering units to plot the data:

• Sec – Choose Sec if you want to plot the data from the counter in seconds.  

• Hz – Choose Hz if you want to plot the data from the counter in Hertz.  

• Counts – Some devices provide the Counts option. Choose Counts if you want to plot the 
number of counts that were counted by the counter/timer.

Max mSec/Hz

When you select Sec or Hz for the engineering units of the counter, you can enter the 
maximum value for the Y axis in the Max mSec/Hz field.

Start Edge

For each supported counter, select the signal edge that will start the measurement. You can 
choose from the following signals (note that not all options are provided by all devices):

• A/D Complete

• Tach Rising (on the DT9837 Series, this is supported by the Tach Counter only)

• Tach Falling (on the DT9837 Series, this is supported by the Tach Counter only)

• Clock Rising

• Clock Falling 

• Gate Rising (on the DT9837 Series, this is supported on the Gate Counter only)

• Gate Falling (on the DT9837 Series, this is supported by the Gate Counter only)

Stop Edge

For some devices, you can specify the stop edge of the counter, which stops the measurement. 
You can choose from the following signals:

• A/D Complete

• Tach Rising (on the DT9837 Series, this is supported by the Tach Counter only)

• Tach Falling (on the DT9837 Series, this is supported by the Tach Counter only)

• Gate Rising (on the DT9837 Series, this is supported on the Gate Counter only)

• Gate Falling (on the DT9837 Series, this is supported by the Gate Counter only)



Configuring Channels and the Acquisition Settings
Quadrature Decoder Channel Settings

This section describes the settings that you can configure for quadrature decoder channels that 
are supported in the analog input data stream. 

Engineering Unit (EU)

For each counter, you can choose from one of the following engineering units to plot the data:

• Deg – Choose Deg if you want to plot the data from the quadrature decoder in degrees.  

• Counts – Choose Counts if you want to plot the number of counts that were counted by 
the quadrature decoder.

Pulses/Rev

Enter the number of pulses per revolution for your quadrature encoder. This number is 
device-specific; therefore, refer to the documentation for your quadrature encoder to 
determine this number.

Clock Prescale

Enter the pre-scale value that is used to filter the onboard clock. Using a clock pre-scale value 
can remove ringing edges and unwanted noise for more accurate data.

X4 Scaling

The scaling mode (X1 or X4 mode), determines the resolution of the quadrature encoder. If X4 
Scaling is disabled, X1 mode is used. In X1 mode, the quadrature decoder counts the edges on 
the A signal input. 

If X4 scaling mode is enabled, X4 scaling mode is used. In X4 mode, the quadrature decoder 
counts the edges on the A and B signal inputs. Therefore, if a quadrature encoder has 360 
pulses per revolution, X1 mode yields 360 counts when the quadrature encoder is rotated 360 
degrees. X4 mode yields four times the number of counts, or 1440 (360 x 4) when the 
quadrature encoder is rotated 360 degrees.

Index Mode

You can specify one of the following for the Index Mode:

• High – The Index input is enabled and the positional count is zeroed on the high edge of 
the Index signal.

• Low – The Index input is enabled and the positional count is zeroed on the low edge of 
the Index signal.

• Disabled – The Index input is disabled and the positional count is not zeroed. Note that if 
X4 Scaling is Enabled, Index Mode must be disabled.
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Applying and Saving Changes

Click Close when you are through with this dialog box to apply the changes you made to the 
hardware and to reconfigure the application, as needed. 

For information on saving and loading a configuration file, refer to page 28. For information 
about the backup configuration file, refer to page 29.
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Configuring the Settings of the Recording Tab
Before starting acquisition, configure how the data is recorded using the Recording tab of the 
Acquisition Config window:

The recording settings are described as follows:

• Filename generation – Specify how to create the name of the file. You can choose one of 
the following options:

− Filename – The specified filename is created when you click the Record toolbar button 
(  ). Each time you click the Record toolbar button, you will be prompted to 
overwrite the file. QuickDAQ Data.hpf is an example of a filename that was created 
using the Filename option.

− Filename-Sequence – The specified filename is created and a starting number that you 
define is appended to the filename when you click the Record toolbar button
(  ). Each time you click the Record toolbar button, the number that is 
appended to the filename is incremented by one. QuickDAQ Data-1.hpf is an example 
of a filename that was created using the Filename-Sequence option.
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− Filename-DateTime – The specified filename is created and the current date and time is 
appended to the filename when you click the Record toolbar button (  ). 
Each time you click the Record toolbar button, the filename with the current date and 
time is created. QuickDAQ Data-2012-11-15_02-15-31-PM.hpf is an example of a 
filename that was created using the Filename-DateTime option.

• Filename base – Specify the name of the High Performance binary file (.hpf) in which to 
store the data that is recorded when you click the Record toolbar button (  ). 
The default path is shown. You can change this path, if desired. The application saves the 
data file path and is uses this path by default.

• Enable Continuous Acquisition – Determines how data acquisition and processing stops.

Check this checkbox to enable continuous acquisition. In this mode, you must click the 
Stop button or hold down the Shift key and press the F5 key to stop 
acquisition/processing.

If the Enable Continuous Acquisition checkbox is unchecked, you must specify how long 
to acquire data using the Acquisition Duration.

• Acquisition Duration – (Available only if the Enable Continuous Acquisition checkbox 
is unchecked). You can either enter a value that specifies the number of days (dd), number 
of hours (hh), minutes (mm), and seconds (ss) that you want to acquire data from the 
device, or select one of the following predefined values from the combo box:

− 10 Seconds

− 1 Minute

− 5 Minutes

− 10 Minutes

− 30 Minutes

− 1 Hour

− 5 Hours

− 12 Hours

− 1 Day

− 2 Days

If the Enable Continuous Acquisition checkbox is unchecked, acquisition stops 
automatically when the specified duration elapses. 

• X Axis Span – You can either enter a value that specifies the number of days (dd), number 
of hours (hh), minutes (mm), and seconds (ss) that you want to use for the span of the 
x-axis of the plots on the Channel Plot window, or select the default value from the combo 
box.

Note: If you specify a value for the x-axis span that is less than the acquisition duration, 
the x-axis scrolls using the span you specified.

• Notes – Use this field to add any notes as desired. If you choose to export the data to 
ASCII, this information is also exported.



Configuring Channels and the Acquisition Settings
Based on the information that you enter for the Recording tab and the Acquisition tab, the 
software configures the hardware and displays the following configuration settings used by 
the device:

• The actual sample rate used by the device.

• The actual sample interval used by the device.

• The actual number of scans to acquire.
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Configuring the Settings of the Acquisition Tab
Use the Acquisition tab of the Acquisition Config window to set up parameters that apply to 
the A/D subsystem of the device, including the sampling frequency, trigger source, filter type, 
temperature units, channel configuration, and/or input voltage range.

Sampling Frequency

Enter the sampling frequency per channel for the device. For simultaneous devices, the total 
throughput is the same as the per channel sampling frequency, since all channels are acquired 
at the same time.

For multiplexed devices, multiply the per channel sampling frequency by the number of 
enabled channels to determine the total throughput. For example, if five analog input 
channels are enabled on the multiplexed device and the per channel sampling frequency is 
200 Hz, the total throughput is 1000 Hz (200 Hz x 5). 

Refer to the user’s manual for your device for information on the supported sampling 
frequencies.



Configuring Channels and the Acquisition Settings
Trigger Source

Specify the trigger source that starts acquisition on the device. Examples of trigger sources 
that may be supported for starting acquisition on the device include the following:

• Software – The device starts acquiring scans when you click the Record button or press 
the F5 key. Once acquisition starts, all triggers are ignored. Acquisition stops when the 
conditions defined in the Recording tab, described on page 81, are met.

• External TTL Pos Edge – The device starts acquisition when it detects a rising-edge 
voltage on the external trigger line. Once triggered, the state of external trigger line is 
ignored. The process continues until the conditions defined in the Recording tab, 
described on page 81, are met. 

• External TTL Neg Edge – The device starts acquisition when it detects a negative-edge 
voltage on the external trigger line. Once triggered, the state of external trigger line is 
ignored. The process continues until the conditions defined in the Recording tab, 
described on page 81, are met. 

• Analog Threshold Pos Edge – The device starts acquisition when it detects a positive 
edge, analog threshold trigger event. You can specify the threshold value on which to 
trigger and the channel to use for the analog threshold trigger.

• Analog Threshold Neg Edge – The device starts acquisition when it detects a negative 
edge, analog threshold trigger event. You can specify the threshold value on which to 
trigger and the channel to use for the analog threshold trigger.

For example, assume that you specified the trigger source as External TTL Pos Edge, set the 
Acquisition Duration field on the Recording tab to 5 Seconds, and clicked the Record toolbar 
button (  ) or pressed the F5 key. In this example, the device waits until it detects a 
rising-edge TTL pulse on external trigger line before acquiring data. When five seconds of 
data are acquired, acquisition stops.

Refer to the user’s manual for your device for information on the supported trigger sources.

Filter Type

If supported by your device, you can configure one of the following filter types:

• Moving average – (The default filter setting.) This filter type removes unwanted noise 
from your measurements and provides a compromise of filter functionality and response 
time. This filter can be used in any application.

This low-pass filter takes the previous 16 samples, adds them together, and divides by 16.

• None – No filter. Provides fast response times, but the data may be difficult to interpret. 
Use when you want to filter the data yourself.

The data is represented exactly as is when it comes out of the Delta-Sigma A/D 
converters. Note that Delta-Sigma converters provide substantial digital filtering above 
the Nyquist frequency.

Generally, the only time it is desirable to use the None filter setting is if you are using fast 
responding thermocouples, sampling them at higher speeds (> 1 Hz), and need as much 
response speed as possible.
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Temperature Units

For thermocouple and RTD measurements, you can select the temperature units (Celsius, 
Fahrenheit, and Kelvin) into which the voltage data is converted. This setting is applied to all 
the temperature channels of the device.

You can see which temperature unit will be displayed for each channel in the Configure 
Devices dialog box, described on page 60.

Single-Ended or Differential Channel Configuration

If your device supports it, you can select the following channel configuration for the A/D 
subsystem:

• Single-ended – Choose this configuration when you want to measure high-level signals, 
noise is not significant, the source of the input is close to the device, and all the input 
signals are referred to the same common ground. Refer to the user’s manual for your 
device for wiring information.

• Differential – Choose this configuration when you want to measure thermocouple or 
low-level signals, you are using an A/D converter with high resolution, noise is a 
significant part of the signal, or common-mode voltage exists. Refer to the user’s manual 
for your device for wiring information.

Input Voltage Range

If your device supports multiple input voltage ranges and/or gains, you can select which 
effective input range to use for the A/D subsystem. For example, if your device supports and 
input range of ±10 V with gains of 1 and 2, two effective input ranges are supported: ±10 V 
(±10 V divided by a gain of 1) and ±5 V (±10 V divided by a gain of 2).

Refer to the user’s manual for your device for specific information on the input voltage ranges 
and gains that are supported.
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Configuring the Appearance of the Channel Display 
Window

This section describes the how to configure the appearance of the Channel Display window, 
and includes the following topics:

• Displaying channels in the Channel Display window, described on this page

• Controlling how data is displayed in the Channel Display window, described on page 90

• Specifying the style of the Channel Display window, described on page 92

Displaying Channels in the Channel Display Window

You can determine which channels are displayed in the Channel Display window by using the 
following controls in the Plot and Data Config window:

You can see the names of all enabled channels under the Channel Name column in the Plot 
and Data Config window. Only data from the list of enabled channels is acquired. 

Note: If desired, you can change the name of a channel using the Input Channel 
Configuration menu option, described on page 56.

Hide/show columns

Multi-channel Actions

Channel Name
Column

Visible Column 
for Channel 

Display Window



Configuring the Display
For each enabled channel, you can control which channels are displayed in the Channel 
Display window using the Visible Display checkbox. If a box is checked under the Visible 
Display column, the data for the associated channel is displayed in the Channel Display 
window. If a box under the Visible Display column is unchecked, the data for the associated 
channel is not displayed in the Channel Display window. 

Note: Data for all enabled channels is recorded regardless of whether the channel is visible.

Making All Selected Channels Visible or Hidden in the Channel Display 
Window at Once

If you want to make all selected channels visible in the Channel Display window at once, 
select the Multi-channel Actions button (  ), and choose Selected channels 
visible in Channel Display.  

If you want to hide all selected channels in the Channel Display window at once, select the 
Multi-channel Actions button (  ), and choose Selected channels hidden in 
Channel Display. 

Showing or Hiding the Visible Display Column

If you wish, you can change whether the Visible Display column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Visible Display. A checkmark 
means the column is shown; no checkmark means the column is hidden.

Moving the Visible Display Column

If you wish, you can move the position of the Visible Display column by clicking the 
left-mouse button to select it, dragging it to the right or left, and letting go of the left-mouse 
button.
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Controlling How Data is Displayed in the Channel Display Window

Using the Channel Display - Control tab in the Plot and Data Config window, you can control 
how data is displayed in the Channel Display window. 

You can configure the following settings:

• Hide Unused Channels – By default, the Channel Display window resembles the front 
panel of the device and shows up to 48 channels. However, if you want your display to 
show only the enabled channels rather than all the channels, check the Hide Unused 
Channels box. The following example illustrates how the display looks when three 
channels are enabled and the Hide Unused Channels box is checked.

• Precision – You can select the number of significant digits after the decimal point to 
display; values range from 1 to 8 (2 is the default).



Configuring the Display
• Columns – You can specify how many columns to use when displaying the channels; 
values range from 1 to 16 (8 is the default). For example, by choosing 1, shown below, you 
can display each channel, one on top of the other (note that the lowest numbered channel 
is always at the bottom of the display and the highest numbered channel is at the top of 
the display):

• Display Update Rate – You can choose how fast you want the display of the Channel 
Display window to be updated. Slide the bar to the left for faster update rates, or slide the 
bar to the right for slower update rates.

• Data Reduction Method – You can choose which value to display in the Channel Display 
window:

− First Value – The first value in the most recent buffer is displayed for each channel.

− Average – The average value in the most recent buffer is displayed for each channel.

− Min – The minimum value in the most recent buffer is displayed for each channel.

− Max – The maximum value in the most recent buffer is displayed for each channel.
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Specifying the Style of the Channel Display Window

Using the Channel Display Style tab, you can specify the style of the Channel Display 
window.

You can configure the following parameters:

• Background color – Allows you to choose a specific color for the background of the 
Channel Display window. You can select from a number of predefined colors or you can 
define your own color for the background.

• Foreground color – Allows you to choose a specific color for the foreground of the 
Channel Display window. You can select from a number of predefined colors or you can 
define your own color for the foreground.

• Label color – Allows you to choose a specific color for the label used on the Channel 
Display window. You can select from a number of predefined colors or you can define 
your own color for the label.



Configuring the Display
• Indicator style – Allows you to specify how the numbers and letters that represent the 
data appear. The following choices are available:

− 7 Segment – The numbers and letters that represent the data are composed of 
7-segment lines.

− 16 Segment – The numbers and letters that represent the data are composed of 
16-segment lines.

− Mechanical – The numbers and letters that represent the data appear to be formed by a 
contiguous line.
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Configuring the Appearance of the Channel Plot 
Window

This section describes the following aspects related to the appearance of the Channel Plot 
window:

• Displaying channels in the Channel Plot window, described on this page

• Displaying data cursors in the Channel Plot window, described on page 96

• Specifying the columns of the Channel Plot window, described on page 97

• Grouping signals in bands on the Channel Plot window, described on page 99

• Specifying the trace color on the Channel Plot window, described on page 101

• Controlling how data is plotted the Channel Plot window, described on page 102

• Specifying the style of the plots in the Channel Plot window, described on page 104

Displaying Channels in the Channel Plot Window

You can determine which channels are displayed in the Channel Plot window by using the 
following controls in the Plot and Data Config window:

You can see the names of all enabled channels under the Channel Name column in the Plot 
and Data Config window. Only data from the list of enabled channels is acquired. 

Channel Name
Column

Visible Column 
for Channel Plot 

Window

Hide/show columns

Multi-channel Actions



Configuring the Display
Note: If desired, you can change the name of a channel using the Input Channel 
Configuration menu option, described on page 56.

For each enabled channel listed under the Channel Name column, you can control which 
channels are displayed in the Channel Plot window using the Visible Plot checkbox. If a box 
is checked under the Visible Plot column, a plot for the associated channel is displayed in the 
Channel Plot window. If a box under the Visible Plot column is unchecked, the plot for the 
associated channel is not displayed in the Channel Plot window. 

Note: Data for all enabled channels is recorded regardless of whether the channel is visible.

Making All Selected Channels Visible or Hidden in the Channel Plot Window 
at Once

If you want to make all selected channels visible in the Channel Plot window at once, select 
the Multi-channel Actions button (  ), and choose Selected channels visible 
in Channel Plot.  

If you want to hide all selected channels in the Channel Plot window at once, select the 
Multi-channel Actions button (  ), and choose Selected channels hidden in 
Channel Plot. 

Showing or Hiding the Visible Plot Column

If you wish, you can change whether the Visible Plot column is shown or hidden by selecting 
the Hide/show columns (  ) button, and selecting Visible Plot. A checkmark means the 
column is shown; no checkmark means the column is hidden.

Moving the Visible Plot Column

If you wish, you can move the position of the Visible Plot column by clicking the left-mouse 
button to select it, dragging it to the right or left, and letting go of the left-mouse button.
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Displaying Data Cursors in the Channel Plot Window

You can determine whether data cursors are displayed in the Channel Plot window by using 
the following controls in the Plot and Data Config window:

For each of the enabled channels, you can choose to display a data cursor in the Channel Plot 
window using the Show Cursor column in the Plot and Data Config window. 

If a box is checked under the Show Cursor column, a data cursor for the associated channel is 
displayed in the Channel Plot window. If a box under the Show Cursor column is unchecked, 
a data cursor for the associated channel is not displayed in the Channel Plot window.

You can enable the capability of moving the data cursor using the data-cursor control (  ), 
described on page 48. Various options are available for changing the cursor style, line style, 
and cursor color. 

Making All Selected Data Cursors Visible or Hidden at Once

If you want to make all selected data cursors visible in the Channel Plot window at once, 
select the Multi-channel Actions button (  ), and choose Selected data cursors 
visible.

If you want to hide all selected data cursors in the Channel Plot window at once, select the 
Multi-channel Actions button (  ), and choose Selected data cursors hidden. 

Hide/show columns

Multi-channel Actions

Show Cursor
Column
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Showing or Hiding the Show Cursor Column

If you wish, you can change whether the Show Cursor column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Show Cursor. A checkmark 
means the column is shown; no checkmark means the column is hidden.

Moving the Show Cursor Column

If you wish, you can move the position of the Show Cursor column by clicking the left-mouse 
button to select it, dragging it to the right or left, and letting go of the left-mouse button.

Specifying the Columns of the Channel Plot Window

You can determine how many columns are displayed in the Channel Plot window by using 
the following controls in the Plot and Data Config window:

You can specify up to six columns to view in the Channel Plot window. 

Under Plot Column, select the column (1 to 6) in which to display the selected channel. The 
following example shows a display of two plot columns, where the thermocouple channels 
are displayed in column 1 and voltage channels are displayed in column 2:

Hide/show columns

Multi-channel Actions

Plot
Column
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Changing the Plot Column for All Selected Channels at Once

If you want to change the plot column for all selected channels at once, do the following:

1. Highlight the channels in the Plot and Data Config window that you want to change.

2. Select the Multi-channel Actions button (  ).

3. Choose Selected channels Plot Column.

4. Enter the number of plot columns to use.



Configuring the Display
Showing or Hiding the Plot Column

If you wish, you can change whether the Plot Column is shown or hidden by selecting the 
Hide/show columns (  ) button, and selecting Plot Column. A checkmark means the 
column is shown; no checkmark means the column is hidden.

Moving the Plot Column

If you wish, you can move the position of the Plot Column by clicking the left-mouse button 
to select it, dragging it to the right or left, and letting go of the left-mouse button.

Grouping Signals in Bands on the Channel Plot Window

You can group signals in bands in the Channel Plot window by using the following controls in 
the Plot and Data Config window:

You can choose to display multiple signals in the same band by assigning the same Signal 
Group letter to them. You can specify a value of A through T for the Signal Group. 

For example, to see the data from analog input signals 1 and 2 in the same band, you could set 
the Signal Group for both channels to A.

If two analog input channels have a different plot data type (for example, one is temperature 
and the other is voltage), two Y-axes are displayed for the band, as shown in the following 
example:

Hide/show columns
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Changing the Signal Group for All Selected Channels at Once

If you want to change the value of the signal group for all selected channels at once, do the 
following:

1. Highlight the channels in the Plot and Data Config window that you want to change.

2. Select the Multi-channel Actions button (  ).

3. Choose Selected channels Signal Group.

4. Enter the value of the signal band to use.

Showing or Hiding the Signal Group Column

If you wish, you can change whether the Signal Group column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Signal Group. A checkmark 
means the column is shown; no checkmark means the column is hidden.

Moving the Signal Group Column

If you wish, you can move the position of the Signal Group column by clicking the left-mouse 
button to select it, dragging it to the right or left, and letting go of the left-mouse button.



Configuring the Display
Specifying the Trace Color on the Channel Plot Window

You can specify the color of the trace on the Channel Plot window by using the following 
controls in the Plot and Data Config window:

For each channel, select the Color column, and then select the color that you want to display 
for the trace in the Channel Plot window.  

Showing or Hiding the Color Column

If you wish, you can change whether the Color column is shown or hidden by selecting the 
Hide/show columns (  ) button, and selecting Color. A checkmark means the column is 
shown; no checkmark means the column is hidden.

Moving the Color Column

If you wish, you can move the position of the Color column by clicking the left-mouse button 
to select it, dragging it to the right or left, and letting go of the left-mouse button.

Color
Column

Hide/show columns
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Controlling How Data is Plotted in the Channel Plot Window

Using the Channel Plot Control tab in the Plot and Data Config window, you can control how 
data is plotted in the Channel Plot window. 

You can configure the following settings:

• Plot update rate, – Enter a value between 1 and 50 to indicate how often you want the 
display to be refreshed per second.

• Smooth scrolling – You can adjust how the plot scrolls to the left using the Smooth 
scrolling checkbox. If Smooth scrolling is checked, the plot attempts to scroll after each 
data point is added. However, scrolling is limited by the actual update rate. For example, 
if the Plot update rate is set to 50, and 100 points are added per second (determined by the 
Recording settings), the plot scrolls to the left by 2 samples, 50 times per second.

If the Smooth scrolling checkbox is unchecked, the plot does not attempt to scroll after 
every point is added; instead, it scrolls after each buffer is plotted. The buffer size is set to 
the FFT size.

• Disable during acquisition – This checkbox is provided for fast data acquisition boards, 
such as the DT9832, which acquire data faster than the application can display it. 

If the Disable during acquisition checkbox is checked, no data is displayed in the 
Channel Plot window during acquisition. When acquisition is finished, the data is 
displayed in the Channel Plot window. 

If the Disable during acquisition checkbox is unchecked, the data is displayed in the 
Channel Plot window as the data is acquired.



Configuring the Display
• Under Time domain X axis units, select the units for the x-axis as one of the following:

− Sample number – The units for the x-axis are represented as the number of samples (0 
to the maximum number of samples acquired).

− Relative time – The units for the x-axis are represented as the recording time from 0 to 
the total recording time.

− Absolute time – The units for the x-axis are represented as the actual time of 
acquisition based on the system clock. If you select absolute time, you can select 
whether to represent the time in 24-hour (military) format or 12-hour format.

• Display Milliseconds – Check this checkbox if you want to see the data on the x-axis 
displayed in milliseconds; this setting is useful when you zoom into the data with the data 
cursors shown. If this checkbox is unchecked, the data on the x-axis is displayed in 
seconds. 

• Display Day – If Absolute Time is selected and you check the Display Day checkbox, the 
x-axis shows dd:hh:mm:ss, where dd is the day of the month, hh is hours, mm is minutes, 
and ss is seconds. If Relative Time is selected, the value for day starts at 0 and increments 
by one for each subsequent day. You can also set the value for day in the x-axis options if 
the Display Day checkbox is selected.

• Use the Plot height slider bar, to determine the relative height of each plot in the Channel 
Plot window. Slide the control to the right to increase the height; slide the control to the 
left to decrease the height. Note that the entire screen is always filled, so, typically, this 
setting is useful when you want to view many plots at once.
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Specifying the Style of the Plots in the Channel Plot Window

The Channel Plot Style tab allows you to specify the style of the plots that are displayed in the 
Channel Plot window.

You can configure the following settings:

• Use the Background Color box to choose a different color for the background of the 
Channel Plot window.

• Use the Axis color box to choose a different color for the axes of the Channel Plot window.

• Use the Grid line color box to choose a different color for the grid lines of the Channel 
Plot window.

• In the Trace thickness box, enter the value between 1 and 5 to set the thickness of the line 
used by the trace on the Channel Plot window, where 1 is the thinnest line and 5 is the 
thickest line.

• Under Plot Header, click the Visible checkbox if you want a header displayed for the data 
on the plot, and then enter the text for the header. By default, the header is called Test Data. 
You can also select the color for the header and the font in which to display the header.

• Under X-Axis Label, you can select the color for the label of the x-axis and the font in 
which to display the x-axis label.

• Under Y-Axis Label, you can select the color for the label of the y-axis and the font in 
which to display the y-axis label.



Configuring the Display
Configuring the Appearance of the Statistics Window
You can determine whether statistics are displayed in the Statistics window by using the 
following controls in the Plot and Data Config window:

For each enabled channel listed under the Channel Name column, you can control whether 
statistics are displayed in the Statistics window using the Visible Statistics checkbox. If a box 
is checked under the Visible Statistics column, the statistics for the associated channel are 
listed in the Statistics window. If a box under the Visible Statistics column is unchecked, the 
statistics for the associated channel are not displayed in the Statistics window. 

Making Statistics for All Selected Channels Visible or Hidden in the 
Statistics Window at Once

If you want to make statistics for all selected channels visible in the Statistics window at once, 
select the Multi-channel Actions button (  ), and choose Selected channels 
visible in Statistics Display.  

If you want to hide statistics for all selected channels in the Statistics window at once, select 
the Multi-channel Actions button (  ), and choose Selected channels hidden 
in Statistics Display. 

Hide/show columns

Multi-channel Actions

Visible
Statistics
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Showing or Hiding the Visible Statistics Column

If you wish, you can change whether the Visible Statistics column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Visible Statistics. A 
checkmark means the column is shown; no checkmark means the column is hidden.

Moving the Visible Statistics Column

If you wish, you can move the position of the Visible Statistics column by clicking the 
left-mouse button to select it, dragging it to the right or left, and letting go of the left-mouse 
button.
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Overview
This chapter describe how to use QuickDAQ to configure and run a measurement application.

For this example, the following sensors are connected to a MEASURpoint instrument:

• T thermocouple is connected to analog input channel 0

• 4-wire, Euro PT1000 RTD is connected to analog input channel 8

• ±10 V input signal is connected to analog input channel 16



Example Using QuickDAQ
Configure the Channels
Configure the channels as follows:

1. Configure each analog input channel by clicking the Configuration menu, and clicking 
Input Channel Configuration, or by clicking the Input Channel Configuration toolbar 
button (  ).

2. Enable analog input channels 0, 8, and 16 by clicking the checkbox under the Enable 
column.

3. Under the Channel Name column, enter a meaningful name for each channel. For this 
example, enter the following names:

− For analog input channel 0, enter T Therm as the channel name.

− For analog input channel 8, enter PT1000 RTD as the channel name.

− For analog input channel 16, enter Voltage In as the channel name.

4. Under the Sensor column, select the following sensor types for the analog input channels:

− For analog input channel 0, select Type T as the thermocouple type.

− For analog input channel 8, select Euro PT1000 as the RTD type.

− For analog input channel 16, select +/-10V as the input voltage range.
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5. Under the Engineering Units column, Deg C is selected by default. If you want to change 
this setting, change the temperature units under the Acquisition Config - Acquisition 
tab.
In this example, Deg C is used.

6. If you know the offset for your calibrated thermocouple and RTD, enter it under the EU 
Offset column. For this example, leave 0 as the EU offset for the thermocouple and RTD 
channels and 1000 as the EU offset for the voltage input channel.

7. Leave the test point values for each channel unchanged. 

8. Click Close to close the Channel Configuration dialog box.



Example Using QuickDAQ
Configure the Parameters of the Acquisition Config 
Window

For this example, set the Acquisition Config parameters as follows:

1. Click the Recording tab.

2. For Filename generation, select Filename.

3. Enter a meaningful name for the data file. 
In this example, QuickDAQ Data.hpf is used.

4. Leave the Enable Continuous Acquisition checkbox unchecked.

5. For Acquisition Duration, select 1 minute as the time to acquire the measurement data.
The amount of available disk space is shown; in addition, the number of scans in the Acquisition 
Info area is updated based on the acquisition duration that is selected.

6. For X Axis Span, enter 5 seconds as the span for the x-axis.

7. Click the Acquisition tab.
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8. For this example, ensure that the following default settings are used:

− Sampling Frequency: 10 Hz

− Trigger Source: Software

− Temperature Unit: Celsius

− Filter Type: Moving Average

9. If desired, hide the Acquisition Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.



Example Using QuickDAQ
Configure the Appearance of the Channel Display 
Window

Configure the appearance of the Channel Display window as follows:

1. Ensure that the Visible Display column in the Plot and Data Config window is checked 
for all three enabled channels.

2. Click the Channel Display - Style tab, and select the color scheme that you want for the 
Channel Display window.
In this example, black is used for the background color, green is used for the foreground color, and 
white is used for the label color.

3. Leave the indicator style as 7 segment.
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Configure the Appearance of the Channel Plot Window
Configure the appearance of the Channel Plot window as follows:

1. In the Plot and Data Config window, set up the following parameters:

a. Ensure that the Visible Plot column is checked for all three enabled channels.

b. Leave the Show Cursor column unchecked for all three enabled channels.

c. Under Plot Column, use the default plot column setting of 1 for all three enabled 
channels.

d. Under the Signal Group column, select A for the thermocouple and RTD channels, 
and select B for the voltage input channel.

e. Under the Color column, assign a unique color to each trace.

2. Click the Channel Plot - Control tab, and slide the Plot height bar to the left until you can 
see both plots on the screen at once.
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3. Leave the following settings unchanged:

− Plot update rate: 1

− Smooth scrolling: unchecked

− Disable during acquisition: unchecked

− Time domain X axis units: Relative time

− Display Milliseconds: unchecked

− Display Days: unchecked

4. In the display area, click the tab for the Channel Plot window.

5. Click the Show Legend control (  ) on the toolbar.

6. For the top plot in this window, change the text for the label on the x-axis, by doing the 
following:

a. Right-click on the label.

b. Select Edit Label.

c. Enter the following text: Thermocouple and RTD Channels

7. For the bottom plot in this window, change the text for the label on the x-axis, by doing 
the following:

a. Right-click on the label.

b. Select Edit Label.
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c. Enter the following text: Voltage Channels
The Channel Plot window should appear as follows:



Example Using QuickDAQ
Configure the Appearance of the Statistics Window
Configure the appearance of the Statistics window as follows:

1. Ensure that the Visible Statistics column in the Plot and Data Config window is checked 
for all three enabled channels:

2. If desired, hide the Plot and Data Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.
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Position the Windows
If you want see the data that is displayed in the Channel Display, Channel Plot, and Statistics 
windows at once, you need to move the windows to different locations in the display area.

In the following example, the Channel Display window is located at the top of the display 
area, the Channel Plot window is located in the middle of the display area, and the Statistics 
window is located at the bottom of the display area:
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Perform the following steps to position the Channel Display window at the top of the display 
area, the Channel Plot window in the middle of the display area, and the Statistics window at 
the bottom of the display area:

1. Click the tab for the Statistics window, drag the window toward the middle of the display 
area, move the mouse over the guide on the bottom of the guide diamond, and then 
release the mouse button.
The Statistics window is now placed at the bottom of the display area.

2. Click the tab for the Channel Plot window, drag the window toward the middle of the 
display area, move the mouse over the guide on the bottom of the guide diamond, and 
then release the mouse button.
The Channel Plot window is now placed in the middle of the display area, revealing the Channel 
Display window at the top of the display area.

3. Resize each window, as desired.
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Start the Measurement
Once you have configured the channels and the display area, start acquisition and log data to 
disk by clicking the Record toolbar button ( ). 
Results similar to the following are displayed in the display area.

If desired, you can view the data in Excel by clicking the Open Current Data in Excel toolbar 
button (  ).
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Troubleshooting 
If you are performing an acquisition for a long duration, you may see that acquisition stops if 
your computer’s power options are not set correctly. If this problem occurs, do the following 
to change the power options of your computer:

1. Go to the Control Panel application for your computer.

2. Select Power Options.

3. For the Put the Computer to Sleep option, select Never.

Should you experience other problems using QuickDAQ, do the following: 

1. Read all the appropriate sections of this manual. Make sure that you have added any 
“Read This First” information to your manual and that you have used this information.

2. Check for a README file on the CD. If present, read this file for the latest installation and 
usage information. 

3. Check that you have installed your data acquisition devices properly. For information, 
refer to the documentation supplied with your devices. 

4. Check that you have installed the latest device drivers for your data acquisition devices. 
For information, refer to the documentation supplied with your devices. 

5. Check that you have installed your software properly. For information, refer to page 16 

6. Search the Data Translation web site (www.datatranslation.com) for information about 
QuickDAQ. 

7. Search the Knowledgebase in the Support section of the Data Translation web site (at 
www.datatranslation.com) for an answer to your problem. 

If you are still having problems, Data Translation’s Technical Support Department is available 
to provide technical assistance to licensed users.
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Technical Support 
If you have any difficulty using QuickDAQ, Data Translation’s Technical Support Department 
is available to provide technical assistance.

To request technical support, go to our web site at http://www.datatranslation.com and click 
on the Support link. 

Note: Any unhandled exceptions that occur when running QuickDAQ are captured and 
displayed in a dialog box; these exceptions are also appended to a file called 
QuickDAQErrLog.log off the root directory (C:\QuickDAQErrLog.log). If you receive an 
unhandled exception, please email the QuickDAQErrLog.log file to the Data Translation 
Technical Support Department at support@datx.com.

When requesting technical support, be prepared to provide the following information:

• The version of QuickDAQ that you are using

• The serial number of your data acquisition device
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